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Introduction

The VX3000 Film Imaging System is designed to give you not only high quality image
scanning, but also on-line, interactive previewing and mensuration capabilities. The
VX3000 provides a broad range of resolution, generating precise geometric and
radiometric results. The VX3000's upright, back-lit imaging area doubles as a
traditional light table allowing you to view images through the live video camera. You
can roam and zoom about the image, experimenting with various combinations of
scanner settings such as resolution, brightness and contrast, which allows you to
preview the varous possibilities before actually scanning.

System Configuration

The VX3000 Scanning system, shown below, is configured with a scanner controller,
imaging monitor, and scanner. You run the VX3000 application from your host
workstation using your network.

User Interface Formatting
Host Workstation Host Workstation

Ethernet

Scanner Controller ~ The component that houses the computer hardware and software
(vxscan) for the VX3000 scanner.
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Imaging Monitor The monitor on which you preview the image.

VX3000 Scanner The scanner.

Ethernet A standard Ethernet network that connects the Scanner Controller
to the User Interface and Formatting Host Workstations.

Host Workstation Any workstation that runs UNIX and X Windows, and is
complete with a monitor, keyboard, and mouse. It is from this
workstation that you run the VX3000 User Interface.

Formatting Host A UNIX workstation on which the formatting software
(vxformat) is installed and which is connected to the scanner
controller via Ethernet. It may be the same as the host
workstation.

VX3000 Conventions

The VX3000 User Interface uses standard X Windows conventions. For more detailed
information about X Windows conventions, see your operating system manuals,

Using the Mouse

Within the VX3000 User Interface, the mouse is used to move the camera, select
options, and set scanning parameters. See the Backplane Representation section for
more information on moving the camera with the mouse.

Note: The only time you press the middle-mouse button is to move the camera.
Otherwise, always use the left mouse button. VX3000 does not use the third or right
mouse button.

Mouse Pointer Shapes

The mouse pointer changes shape when it is in different locations within the window.
These different shapes provide visual cues to the current activity.

2 VX3000 Film Scanner User's Manual
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The pointer usually appears as an arrow cursor.

In the Viewing Area, the pointer appears as a cross for adjusting
the size and shape of a scan area. A cross also appears on the
image monitor for selecting points of interest.

+

An inverted "L" bracket appears when you are ready to draw the
r rectangle for defining a Region of Interest,

Clicking, Double-Clicking, and Dragging

Click means to press and release a button without moving the mouse. Double-click
means to click a button twice in rapid succession. Drag means to press and hold a
button while moving the mouse pointer.

Input Fields

Input fields are used to enter text or numerical values, for example, names of Regions
of Interest or absolute resolution values. To select an input field, point to it and click
the left mouse button. The text insertion point is then marked by a blinking I-shaped
cursor in the box. Use the keyboard to type information into an input field. Use the
Backspace and Delete keys to delete unwanted characters. The arrow keys move the
cursor left and right. Some fields, such as the Memo field, can have multiple lines.
Others, such as file names and paths, use standard System V UNIX naming
conventions and sizes. When you are done entering text into a text field, either click on
another text field or option menu, or press <Return>. This will cause vxscan to accept
your input. Using <Return> in a multiple-line text field causes the cursor to advance to
the next line. See the File Naming Conventions section for more information about file
names.

Selection Boxes

Selection boxes allow you to select different options. Some selection boxes have
buttons that you select, and others have fields in which you enter information. Either

VX3000 Film Scanner User's Manual 3
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enter the information requested or select the buttons necessary to complete the function
and select OK. To exit the selection box without saving your ¢hoices, select Cancel.

Message Boxes

Message boxes provide helpful information about system operations. A message box
appears automatically and will often prompt you to select OK to continue. Sometimes a
message box does not require any action. For example, when you select Scan, the
vxscan Working message box displays the progress of the scan,

Pull-Down Menus

Pull-down menus give you access to more options. There are two ways to choose a
function from a pull-down menu using the mouse:

Drag method: Point to the menu you want to display, press and hold the mouse button,
drag the pointer and highlight the desired function, and then release the button.

Click method:. Point to the menu you want to display, click the mouse button once to
display the menu. Point to the desired function and then click again.
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Basic Scanning Steps

This chapter is a brief overview of the basic scanning steps. For detailed instructions
and information about the scanning process, see the next chapters, VX3000 User
Interface Overview, Current Scanner Settings, Current ROI Description, and Menu
Bar.

The scanning process generally follows six basic steps, although some of these steps
are optional depending on your scanning project and defauit scanning parameters.

e Naming the Regions of Interest.

* Defining the geometric parameters such as resolution, size, and location.

* Setting the radiometric attributes such as brightness and contrast, density or
intensity, color or monochrome, lookup tables and filters.

* Selecting formatting options such as file format, pixel depth and formatting host.

* Confirming the Current ROI settings.

* Scanning the image.

Name the Regions of Interest

The Region of Interest (ROI) name is a UNIX directory name to which the image data
(raw 1mage tiles and region header file) are written. This name should be unique for
every region, otherwise previous image data will be overwritten. For more detailed
information on naming a Region of Interest, see ROI Files in the Current ROI
Description chapter.

Define Geometric Parameters

You can interactively change the location and resolution of the scanner to view sections
of your image prior to scanning. While previewing the image, you define a region to
be scanned by drawing a rectangle around the area of interest. Vxscan provides tools
for creating and sizing the rectangles that represent the regions to be scanned. You can
control the ROI size by resizing the ROI rectangle or by providing values for the size in
pixels, the size in inches or millimeters, or the resolution.

VX3000 Film Scanner User's Manual 5
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Set Radiometric Attributes

Part of the scanning setup process involves adjusting the brightness and contrast of the
image using a histogram. You may also choose whether you want the output scanned
in density or intensity modes and whether you want to apply a filter or a lookup table
which wiil remap the digital result.

Select Formatting Options

Before scanning, you select the output file format, the pixel depth, and the name of the
host machine on which you want the formatting process to run.

Confirm the Current ROI Settings

The Current ROI Settings are the values that will be used at the time scanning. As a last
step before scanning, make sure these are set properly because they may differ from the
Current Scanner Settings.

Select Scan

When you have confirmed that the Current ROI Settings are correct you are ready to
scan. You can scan either single regions or multiple regions. During the scanning
process, messages appear telling you about the progress of the scan.

6 VX3000 Film Scanner User's Manual



Starting the Application

Starting the Scanner

Starting the application may vary depending on how the system is set up. The typical
process involves logging in to the host workstation, beginning X Windows, remote
logging into the scanner controller, setting the DISPLAY environment variable,
powering the scanner on, and starting vxscan.

To start the VX3000 Scanner and the vxscan User Interface,

I. Tumn the power on for the scanner and monitor. The green light on the front right-
edge of the scanner is lit when the scanner is on.

2. Make sure that the host workstation is running X Windows and that the scanner
controller is a recognized X host.

3. From the host workstation, remote login to the scanner controiler.

4. Setthe DISPLAY environment variable to your host workstation if it has not been
set properly during the login process.

5. Type vxscan at the UNIX prompt. The scanner will perform a homing sequence,
turning on the backlight, moving to known locations in X and Y, and adjusting the
camera, lens, and filters. The vxscan window then appears on the workstation
monitor. The initial state of the scanner after homing can be optionally specified by
a .vxscanrc file in the home directory. See the Setup and Calibration chapter for
more information about the .vxscanre file.
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Starting the Application

Cleaning the Glass

The View Menu contains a Clean option for cleaning the reseau glass. This option
stmply turns off the scanner backlight and turns on the reseau light for a fixed period of
time to illuminate the glass for ease of cleaning. From the View menu, select Clean.
A message appears telling you how many minutes you have until the backlight comes
back on. You can turn the reseau light off at any time by selecting Cancel. The
limited time period is so that the reseau light is not inadvertently left on for extended
periods. This option may be selected again if the time is insufficient.

Dirty glass, or obscured reseaus, can lead to scanning errors. The reseaus are etched
into the back side of the glass at a width of 100 and depth of 0.75u. Therefore, it is
very easy for fingerprints or other substances to prevent the reseau grid from being
properly recognized.

For best results, use isopropyl alcohol (not ethyl) and many clean, non-abrasive, dust
free wipes. Be careful to pour the solution onto the wipes, and not dip the wipes into
the solution to prevent contamination. Whatever cleaning solution is used, it is
important that it be removed completely so that its streaky residue does not obscure the
reseaus. This can be accomplished by extensive rubbing and buffing of the glass
(especially the back side) with clean wipes.

Mounting an Image

To mount an image,

1. Open the backlight box by grabbing the top of the light box assembly and moving it
away from the scanner.

2. Place the image, emulsion side to the reseau (the etched grid on the front glass
plate), in the backplane viewing area. If you have more than one image, place the
images side by side in the backplane.

3. Close the light box assembly snugly. The image is now mounted.
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Starting the Application

Note: It is imperative that the emulsion side, or coating side, of the film be against
the reseau. The back side of the reseau plate is the focal plane of the scanner. If the
emulsion is separated from the reseau by the thickness of the film, geometric projection

errors will occur.
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Overview of the VX3000 User
Interface

The VX3000 Scanner system provides a user interface called vxscan for setting
scanning parameters, naming files, and defining the areas to scan. This chapter
presents an overview of vxscan's functions.

Regions of Interest

A primary feature of vxscan is the ability to select and define specific areas on the film
that are of interest to your application and which you want to scan. These areas are
called Regions of Interest (ROIs). Scanning one or several regions, each of which may
have different scanning parameters, rather than the entire piece of film, conserves both
time and disk space. An ROI may be defined as a very small subset of the film, or the
entire piece of film. Many regions may be defined for one photo, all of different sizes,
resolutions, and radiometric settings.

The following figure shows an example of three ROIs within a photo.

: 1'0 roi2

roi3

lﬁ' -~ photoph: - - - - 6[

An additional level of abstraction is the photo itself. Information specific to each
region, such as its scanning parameters, coordinates, file name, ete., can be stored in a
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Photo File. All the information for all the regions belonging to a particular photo may
be stored in the same file. In addition, multiple Photo Files may be open and used at
the same time.
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The Vxscan Window

When you start vxscan, the User Interface window appears as shown below.

T i R T

4 File Edit View Options

Current Region cf Interest Description

{Color 2| |Positive @] |Photo: Idefault.ph I
[Trtensity o] [Befault LuTa] ROI: funtitled |
Resalution Image: [Untitled |

10.0 pm/pixel LRaEtET‘ = I iB—B.I.t =] I I on veximg O ]

Contrast Brightness Frormal o] JHemo 2] [Purge = |

1.180 l I +0.170 I mm pixels

1.250 1 +0.200 | Uidth: 10000

1,100, || +0.340 | Height: 8000

{ Apply to Scanner | Scan Scan All !

Current Scanner Settlngs

{Monochrome ] [Positive o

[Density a] [Default LUTS]

Resolution I [No Filter o

75.0 wm/pixel
Contrast I ] Brightnecs I
1.530 | +0.140 ]

[ Apply to ROI |

[opproximate @} [ Corrected = |

LA R CR L sk b L T el o R N B R L BRI P L PR R St 8 ) b Mk ) R L AR KA P K- UV 315 AR i P o AR MR K1 AAARATULAFAR ARRI: R

The vxscan window has three major areas: the Menu bar, the Current Region of
Interest Description, and the Current Scanner Settings.
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Menu Bar

| File Edit View Dptions Help

The menu bar displays the following four pull-down menus and a Help menu:

File Open, close, save, and create new files and exit vxscan.

Edit Create and delete Regions of Interest (ROI's), control ROI rectangle
constraints, specify photo information, and digitize points of interest.

View Display histogram or turn on the reseau light for cleaning the glass.

Options  Set preferences for units of measurement, photo coordinate system visibility
and which dimension is automatically calculated.

For more information on the Menu Bar options and how each one is used, see the
chapter, Menu Bar.
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Current Scanner Settings

The Current Scanner Settings area in the lower half of the window displays the current
settings for the scanner. This is where you can manipulate the scanner settings,
observing the effects of these changes on both the image monitor and histogram until
you achieve the desired results. In order for those changed values to take effect during
scanning, it is necessary to apply the values to the Current Region of Interest
Description above.

Current Scanner Settings

IMDnochrnme :I] tFnSltlve l:l]

{Density 2| [Default LUTa]
[_ Resolution ] [Sharpen =
75.0 um/pixel

| Contrast 1 ’ Brightness ]

| 1.000 i 0.000 }

[ “Apply tc ROT |

[feproximatea] [Corrected o]
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Current Region of Interest Description

The Current Region of Interest Description area displays information about the current
Region of Interest (ROI). The current RO is the one highlighted in the list of regions,
and can be one that you have selected or one that you are creating for the first time. It
can also be an ROI within the default Photo File that appears when you first begin.
You can apply the current ROI settings to the scanner in order to preview the effects of
these settings on the image monitor prior to scanning.

Current Region of Interest Description

ICDLur‘ =] | |F‘osit1ve = ]

Photo: | /filesb/scans/trees,pH

[Dersity =] [Default LUTE] ROI: | /files6/scans/cedar |
Resolution Image: [/FllesS/scans/:edarI I
10.0 un/pixel {Raster o) [B-Bit @] [on veximg O
Contrast Brightress {Hormal o] [No kemo 3| [Purge =X

I £,000 j l +0,300 l mm pixels
1.000 [|  +0.240 [ Wideh: 100,000
1,000 I | Height: 80.000

[ Apply to Scanner I

iles6/scans/aspen
tlesb/scana/birch

'L lesb/scans/Fir

| < —— -

Using Current ROI and Current Scanner Settings

The vxscan User Interface window provides two methods for setting and adjusting
current scanner settings and ROI scanning parameters: using the Current Region of
Interest in the upper portion of the window, or using the Current Scanner Settings in
the lower portion of the window. The Current Region of Interest allows you to select
scanning parameters for a region without affecting the current scanner settings. The
current scanner settings allow you to adjust and preview scanner settings independent
from the values already set for that region. You may "dialog" between these two areas
by using the "apply" buttons. For example, you can apply the current ROI settings to
the scanner to verify that those settings are correct. Alternately, you can experiment
with different scanner settings to determine what are the best settings for a specific
region and then apply it to the region to be scanned. Only the settings in the Current
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Region of Interest are used during the actual scanning process. Selecting a different
ROI will cause the current ROI settings to change to reflect the new ROL

VX3000 Fiim Scanner User's Manual 17



Current Scanner Settings

The Current Scanner Settings area in the lower half of the application window displays

the current settings for the scanner.

Current Scanner Settings

iMunnchr‘Dme ﬂ] LPDsitive :II

I Density o] [Default LT |
[ Resoiution | [Sharpen =1
75,0 um/pixel
l Contrast —” Brightness |
{  1.000 [ o.000 |

{__@pply to ROI ]

I |fpproximated| [Corrected o |

Backplane Representation

Within the Current Scanner Settings area, a backplane representation of the 20" by 10"
backlit scanner surface is displayed in the lower right portion of the window. This area
is a visual representation of the scanner backplane, containing the camera field of view
and rectangles defining ROIs and photo coordinate systems. The image within the
current camera field of view is visible on the image monitor. This Backplane
Representation is where you move the camera to roam in X and Y, define the position
of your Region of Interest, digitize points of interest, or establish optional photo

coordinates,
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Backplane Representation

The Backplane Representation has three types of boxes, each with a different color:

+ the camera field of view shown in dark blue

« the current Region of Interest shown in red (all other regions are magenta)

« optional current photo coordinates shown in green (other photo coordinates are
cyan)

Camera Field of View

The dark blue box in the Backplane Representation represents the camera field of view.
The camera field of view is that portion of the backplane currently visible by the
camera. You can roam about the backplane by moving the cursor into the backplane
representation and pressing and holding down the middle mouse button as you move in
the X and Y directions, dragging the camera field of view. Releasing the middle mouse
button will cause the image to be regrabbed. By adjusting the resolution, you can also
zoom in on a specific area (Z axis). As the resolution setting is changed, the camera
field of view will become respectively larger or smaller. See Resolution and
Radiometric Controls later in this chapter.
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To move the camerua,

1. Position the mouse pointer within the Backplane Representation and hold down the
middle mouse button while moving the mouse. This grabs the camera and moves it
to a new location within the backplane. As you hold down the button and roam, the
camera field of view is displayed on the image monitor in "live"” mode.

2. Release the middle mouse button when you are satisfied with the new camera
position. As soon as you release the mouse button, the camera re-grabs and re-
displays the image.

Moving the mouse cursor inside the camera field of view will cause the cursor to be
drawn on the image monitor. The cursor will appear to slow down in the backplane
representation, but will move at normal speed on the image monitor. Especially at high
resolutions, the cursor may appear to be trapped in the camera field of view, and the
mouse will need to be moved a comparatively great distance to exit the camera field of
view.

Region of Interest Rectangles

One of the steps in defining your scanning area is to draw a rectangle around the area to
be scanned. Before doing this, you may want to set some parameters for that rectangle,
such as the correct units of measurement. See the Options Menu section in the Menu
Bar chapter for more information.

Drawing an ROI Rectangle

If you are creating a new ROI, the position of the ROI in the backplane may be
undefined, in which case the cursor appears as an inverted L bracket in the Backplane
Representation. Clicking the left mouse button will place the upper left corer of the
ROI at your current position. The size of the new ROI rectangle is determined by the
size and resolution settings in the Current ROI Description. The resultant ROI rectangle
may be moved or rubberbanded to resize the region, as described below. See New
ROl in the Edit Menu section of the Menu Bar chapter for more information on creating
anew ROIL
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Backplane Representation

If your application requires very accurate positioning where regions must be at precise,
known locations with respect to film locations, you must turn on Accurate Mode before
positioning an ROl rectangle. See Accuracy later in this chapter.

To draw and resize a new Region of Interest rectangle,

1.

In the Backplane Representation, move the cursor to the upper left corner of the
area you want to scan. The pointer will appear as an inverted "L" bracket outside of
the camera field of view. Inside the camera field of view, the pointer will appear as
a"+". To position accurately with respect to the film, the cursor needs to be within
the camera field of view (where the camera is positioned over the comer of the RO,
and the cursor is visible on the image monitor), with Accurate Mode turned on.

Press the left-mouse button. A rectangle appears with an "X" in the upper left
corner. Use this corner to reposition the rectangle by pointing to the "X" and
holding down the left mouse button while dragging the rectangle to another
location.

The "X" indicates a defined corner point which constrains the other corners of the
rectangle. When just one corner is defined, the other three corners can be
"rubberbanded” to resize the rectangle, and moving the defined point moves the
entire rectangle. When more than one corner is defined, the resizing behavior is
dependent on the relationship between the constraining points and the corner to be
resized. Often you will select two adjacent corners to constrain the opposite corners
of the rectangle from moving in either the horizontal or vertical directions. For
example, if you clicked on the upper left and lower left corners, the upper and
lower right corners are constrained from rubberbanding in the vertical direction.
Conversely, if you clicked the upper left and right corners, you would constrain the
lower corners from moving in the horizontal direction. Selecting opposing corners
prevents the undefined corners from being resized. Defining all four corner points
effectively "locks" the rectangle and prevents any resizing.

To delete a constraining corner point, make it the active point by clicking on it, and
then select Release Point from the Edit menu to release the active corner.
Active, or current corners are drawn in read. Other comers are drawn in magenta.

22 VX3000 Film Scanner User's Manual



Current Scanner Settings
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Note: If you have selected "Size in millimeters/inches" for automatic calculation, you
will not be able to dynamically resize the ROI rectangle because the ROI is constrained
by the resolution and pixel size settings. See the Options Menu section in the Menu Bar
chapter for more information about automatic calculations.

Making an ROI the Current ROI

When working with several Regions of Interest, you will notice that the currently active
ROI rectangle is displayed in red, while the inactive ROI rectangles are displayed in
magenta. An ROI rectangle can be made active either by clicking near or close to a
corner of that rectangle, or by seiecting the ROI name in the list of regions.

Deleting the Current ROI Rectangle

Deleting a rectangle deletes the position definition of an ROI only, not the region and its
parameters.

To delete an ROI rectangle,

1. First make sure that the rectangle you want to delete is the current ROI rectangle.
Either select it from the list of regions or click on the rectangle in the Backplane
Representation.

2. From the Edit menu, select Delete Rectangle.

Scroll Bars

Use the scroll bars on the right and lower edges to adjust the currently visible part of
the Backplane Representation. To move vertically, click on the up and down arrow on
the right side. To move horizontally, click on the left and right arrows at the bottom.
You can also click and drag either bar.

The purpose of the scroll bars is to compensate for the difference in aspect ratios
between the Backplane Representation and the scanner. If the aspect ratios were the
same, the scroll bars would be fuil width and height and would not scroll. For ease of
use, use the maximize option of X Windows to enlarge the window as much as
possible rather than using the smaller default size.
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Photo Coordinate Rectangles

In addition to the camera field area and the ROI rectangles, a photo coordinate system
may be associated with each of the Photo Files. The optional Photo Coordinate
rectangle can be used to establish a photo coordinate system using known points on the
image. Photo coordinates are depicted by a green rectangle for the current photo, and
cyan rectangles for other opened photo files. For more information about using photo
coordinates, see Options section in the Menu Bar chapter.

Resolution and Radiometric Controls

Vxscan's Current Scanner Settings area contains several resolution and radiometric
settings that affect your preview of the image. The image monitor will reflect the
changes made to these settings, but when the image is scanned, only those settings in
the Current Region of Interest Description will be used. Remember to apply any
changes made in the Current Scanner Settings to the Current Region of Interest before
scanning if so desired.

! [Coior o] [Positive 4|
{Dansity o | [Default LUT &1
| Resolution | [Sharpen o]
| 25.0 {um/pixel
[ Contrast I [ Brightress |
[ 1.100 [ +o0.220 |
| 1.100 {[ +0.250 |
{  1.100 {[ +o.300, |
{ Aapply to ROI |
[Approximate=| { Corrected o
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Color Type (Monochrome/Color)

The Color setting specifies the type of image as either color (RGB) or monochrome.
To scan a color image in monochrome, select monochrome instead of color. If you
select Monochrome, one Contrast and one Brightness input field appears. If you select
a color, three Contrast and three Brightness input fields appear for RGB.

Image Type (Positive/Negative)
Type indicates the output results as either positive or negative. Negative causes the

gray values of the image to be inverted, causing negative film to be displayed as
positive on the image monitor.

Intensity/Density

To understand the difference between the Intensity and Density settings, some common
terms need to be reviewed.! 2 When film is processed, areas of the image receive
different amounts of illumination and thus have varying degrees of blackness. The
blackness of a negative, or its light-stopping power, can be expressed numerically in
the following different ways:

Transmittance

Transmittance is the ability of a material to allow light to pass through it and is usually
expressed as a fraction or a percentage: what comes out divided by what went in. For
example, if 100 units of light are directed at a material and 90 units actually pass
through, the transmittance of the material is 9/10, or 90%.

Opacity
Opacity is just the opposite of transmittance. Opacity refers to a material's ability to
block or absorb light. It can be found by dividing 1 by the material's transmittance and

its value can never be less than 1. Using the example above, the opacity of the material
would be L.11.

1Ralph E. Jacobson, Sidney F. Ray, and Geoffrey G. Attridge, The Manual of Photography, Focal
Press, Butterworth-Heinemann Litd. 1988, pp.170-171.

2phil Davis, Beyond the Zone System, 3rd Edition, Focal Press, Butterworth-Heinemann Ltd. 1993, p. 26.
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Density

Density is the common log of opacity. For example, if a material transmits 25% of the
light that strikes it, 25% is equivalent to the fraction of 1/4, the reciprocal of which is 4.
The opacity of the material is therefore 4, and the density is the log of 4, or 0.604.
Here are some examples to help clarify this relationship.

% Transmittance Opacity Density
100 1 0

75 1.33 0.124
50 2 0.3

33.3 3 0.48

20 5 0.7

10 10 1

5 20 1.3

2 50 1.7

1 100 2.0

Density is the unit used most often in sensitometry. Like opacity, it increases with
increasing blackness, but has the following advantages:

1) The numerical value of density bears an approximately linear relationship to the
amount of silver or image dye present. For example, if the amount present in an image
of density 1.0 is doubled, the density is increased to 2.0, The opacity, however,
increases from 10 to 100, or tenfold. Thus, calculations between several optical
components that are multiplicative because they use transparency or opacity, become
additive when using optical density.

2) The final aim is to relate the tones of the print to those of the subject. Blackness in
the print depends on the way the eye assesses it, and is therefore essentially
physiological. The law governing the effect produced in the eye when stimulated is not
a simple one, but over a wide range of viewing conditions the response of the eye is
approximately logarithmic. Thus, if we examine a number of patches of a print in
which the density increases by equal steps, the eye accepts the steps as of equal
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blackness increase. From this point of view, a logarithmic unit is the most satisfactory
measure of blackening.

Using the Vxscan Intensity/Density Settings

The vxscan Intensity setting is essentially transmittance and the vxscan Density
setting is the density value, or log transform of Intensity. So, which setting is
appropriate? Use Density to accentuate structures within the darkest areas. Use
Intensity to accentuate structures in the brightest areas. Your choice also depends on
the final film writing process; use Density if your printing setup assumes density data.

Lookup Tables (LUTs)

A custom Lookup Table (LUT) is an ASCII (text) file that specifics how original or
input gray values (0-255) are mapped to output gray values (0-255). The file contains
256 lines of paired integers separated by blanks or tabs. This file can contain optional
comments, preceded by a '# sign as the first character on a line. It is recommended
that the name of a custom LUT end in "lut' to aid in managing the files. The following
is an example of a LUT file:

#log LUT
#

0 0

1 31

2 50
3 63

254 255
255 255

In the example, the first two lines are comments. The next 256 lines specify a mapping
between input gray values such as 3, and the corresponding output gray value such as

63.
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Because LUTs are tedious to create using a text editor, it is recommended that they be
generated by spreadsheets or other software. Vxscan does not include tools to produce
custom LUTs.

Vxscan allows a custom LUT to be associated with each color channel {white, red,
green, and blue). If the "Current Scanner Settings” are set to Monochrome and
"Custom LUT" is selected, then a file selection dialog box is displayed. This allows
you to specify the name of the custom monochrome LUT. If the "Current Scanner
Settings are set to Color, you are prompted to enter Custom LUTS for red, green, and
blue. These LUTs may be the same or different for each color.

After selecting the name or names of the LUTs, the display on the image monitor and
optional histogram will reflect the application of the LUT(s) to the image. Use of the
LUT(s) may be disabled/enabled by toggling between "Default LUT" and "Custom
LUT". The LUT(s) may be applied to the ROI by using the "Apply to ROI" button.

Because custom LUTs are files, they can also be managed by using the vxscan File
menu. By using Open/LUT/Monochrome,Red,Green,Blue, you can load a LUT for
each color channel. If a LUT has already been loaded for a given channel, it will be
closed and replaced. Close/LUT/Monochrome,Red,Green,Blue removes the
association between a LUT and a color channel.

Resolution
There are two ways of setting the resolution:

»  Click on the Resolution button in the Current Scanner Settings area to display a
resolution slide bar. Drag the slider to adjust the resolution.
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180,04

+ Type the resolution value into the text box below the Resolution button in either the
Current Scanner Settings area or the Current Region of Interest Description area.

If you want a precise resolution level, type the value in the box. If you type the value
in the Current ROI, you must apply the settings to the Current Scanner Settings in order
to view the results. You can also experiment with values by clicking on the Resolution
button and using the slider bar. As you change the resolution setting, the camera box in
the Backplane Representation changes size and the image monitor reflects the actual
field of view of the camera.

Note: If you have selected to have the resolution automatically calculated by using
the Auto Calculate Dimension option in the Set Preferences selection box, you will not
be able to adjust the resolution in the Current Region of Interest area. See the Options
Menu/Set Preferences section in the Menu Bar chapter for more information.

Filters

The No Filter/Sharpen selection box allows you to select an optional high pass edge
enhancing filter to be passed over the data. See the Filters appendix for more
information.

Brightness and Contrast

The purpose of the Brightness and Contrast controls is to match the characteristics of
the image to the range of numbers that are used to represent the brightness of each pixel
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in the image. This range of numbers, or gray values, extends from O for the darkest
part of the image to 255 for the brightest part. The goal is to use as much of this range
as possible. For example, if an image was low in contrast, i.e. it started out with gray
values between 150 and 240, you would want to stretch it so that what was 150
becomes 0, and what was 240 becomes 2535, thereby using the full range. Or if an
image was dark, you would want to increase the brightest value from, for example, 200
up to 255. By adjusting the Brightness and Contrast settings, you can achieve a more
optimal range and distribution of gray values for monochrome images and color values
for color images.

Note: For best results, always adjust Brightness before adjusting the Contrast.

Pressing either the Brightness or Contrast buttons displays a histogram. You can also
select Histogram from the View menu. For a monochrome image, the following
dialog box appears.

Contrast Brightness

‘

180 |[ 3302 ” 1.344 Fls PElcee;. |

Gray Level # Pixels Percent

0.36 | -1.00
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The slide bar on the right adjusts the brightness of the image and the slide bar on the left
adjusts the contrast of the image. The X axis on the histogram depicts the available
range from dark (0, on the left) to light (255, on the right), while the Y axis depicts the
number of pixels in the camera field of view at the corresponding gray value. Thus, in
the example above, the field of view contains values ranging from about gray value 40
to 235, with peaks at 85, 135, and 180.

You can also see specific gray levels and number of pixels by clicking anywhere inside
the histogram. The boxes at the bottom of the histogram display the gray level for that
point (0-255), the number of pixels in the image that contain that gray level, and also
the percentage of the total number of pixels that contain that gray level. In the example
above, clicking on a point within the histogram displayed a gray level of 180. 3302
pixels in the image have this value which is 1.344% of the total number of pixels.

Adjusting Brightness

The Brightness control is used to control the overall brightness of the resultant image.
Increasing brightness increases the amount of light transmitted through the film to the
camera. Decreasing brightness lowers the light level. The brightness adjustment
effectively moves the entire histogram either to the right (brighter) or to the left
(dimmer), without having much effect on the range of the gray values used.

0 255

This histogram shows a less than ideal match between the image intensities
and the gray values representing the image pixels. Note that no pixels have

- .1’“
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a gray value of 0 or 255, thus reducing the radiometric resolution. To
correct this, increase both the brightness and contrast.

To properly set the brightness, first make sure that the resolution is set to the resolution
at which you will be scanning. Move the camera field of view to the brightest parts of
the image and look at the histogram. Adjust the histogram such that there are just a few
pixels with a gray value of 255. The histogram should be just falling off, not peaking.
Move the Brightness slider bar up to increase the brightness (sliding the histogram
right), down to decrease (sliding the histogram left). If you see a spike at 255,
decrease the brightness. If the brightest pixel has a value less than 253, increase the
brightness. It is a good idea to check several bright areas on the image, and set
according to the brightest one. Be careful to look only at the film and not include any
of the empty backlight in the camera field of view.

Note: Spikes in the histogram can also be caused by dirt or scratches on the film.

.‘||N|1fﬁf,.

This shows the effect of increasing the brightness. Note that as the right
hand side of the histogram is moved towards the right, or 255, that the left
hand side moves up as well. This is the proper setting for the brightness
control.

32 VX3000 Film Scanner User's Manual



Current Scanner Settings

Resolution and Radiometric Controls

0 | 255

This histogram is an image that is too bright. Note the big spike at 255
(the highest gray value). This will result in clipping, whereby bright areas
of the image with different brightness levels will all be represented by 255,
thus destroying the detail in those areas. To correct this, decrease the
brightness. The contrast control may also have to be adjusted, either up or
down.

Adjusting Contrast

The Contrast control can be thought of as the "stretch" factor. The Contrast value is the
number used to scale the gray value range. Thus, setting it to 1.0 does no scaling and
is considered the normal setting. Setting it greater than 1.0 stretches the histogram,
away from the gray value 255. For example, assume that the Brightness control is set
so that the brightest gray value in the image is 255. Assume that with the Contrast set
to 1.0, the darkest gray value is 35. The goal is to stretch or rescale the histogram from
the 255 side so that 35 becomes 0. You can also compute the Contrast number by
dividing 255 by the original range. In this example, the original range was 255 to 35,
for a range of 220. 255 divided by 220 equals 1.13, so you would set the Contrast to
1.13. Be aware that if you stretch the Contrast too much, some values will be clipped
at 0.
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This shows the effect of increasing the contrast control. Note that the right
hand, bright side stays in the same place at 255, and that the left hand side
of the histogram get stretched towards zero. This is the proper setting for
the contrast control. The brightness should be adjusted first.

To set the Contrast for an image, use the resolution you will use at scanning time.
Move the camera field of view to the darkest parts of the image and look at the
histogram. Move the Contrast slider bar up to increase the contrast, down to decrease.

Setting the Contrast to a value less than 1.0 will shrink the histogram to the right
toward 255 so that the gray value zero will map to something greater than zero. For
example, if you set the Contrast to 0.97, O will map to 255 minus (255 times 0.97) or
7. With this setting, there will be no gray values less than 7 in the resulting digital
image, regardless of how dark the image is. Thus, setting the Contrast to a number
less than 1.0 actually shrinks the output gray value range and would rarely be desired.

Color Histograms

Setting the Brightness and Contrast controls becomes a little more complex when
working with color images. To set the Brightness, follow the same steps you would
for black and white except look at something white and bright. If there is nothing
white, you will have to set it by eye by looking at the preview image. Set all three
brightness values such that the peaks line up about the same gray value for optimum
color balance. It is common for the three brightness settings to be different. Make sure
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that the image is not saturated (i.e. there is no spike at 255 in any histogram). To set
the Contrast, go to the darkest area and proceed as with black and white except you
should set all the Contrast controls to the same value (use the smallest individual
setting). If you do not do this, areas of different opacities on the film would have
different color balances. This would mean, for example, that a gray step wedge could
be greenish in the bright areas, white in the middle areas, and red in the dark areas.

Note: Every time a value in the current scanner settings is changed, the image is
regrabbed. This regrabbing process is slow in color. For faster results in color, set the
values in the Brightness/Contrast boxes in the Current ROI Settings, not in the
histogram, and then apply to the scanner.
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Setting up Negatives

In negative mode, the radiometric controls behave differently. Increasing the
brightness shifts the histogram to the left, and increasing the contrast stretches it to the
right. For color negatives, setting the color balance can be difficult, and generally must
be done by looking at the preview image. If a black area in the film is known to be
white, then the histogram peaks can be lined up using the brightness and contrast
controls. Remember that in color, all three contrast values should be set the same.

Apply to ROI

This button applies all of the Current Scanner Settings to the Current ROI above, As
explained previously, changes you make to the Current Scanner settings while you
preview the image are not automaticaily used when you scan. You must use the Apply
to ROI button to apply those settings to the Current ROI for the actual scanning.

Accuracy

Vxscan uses two different toggle buttons for determining whether to apply corrections
to the image while you preview: Accurate or Approximate modes control geometric
accuracy, and Corrected or Raw modes control the application of radiometric
corrections.

Accurate and Approximate Modes

Vxscan operates in two modes, Accurate and Approximate. Accurate mode uses the
reseau grid to accurately determine the camera position, while Approximate mode does
not. For this reason, use the Approximate mode while roaming and zooming for faster
movement as you preview an image. Use the Accurate mode to precisely position your
RO rectangles relative to the film or when you establish photo coordinates. You can
also have vxscan remind you with a message whenever you are not in Accurate mode.
See the Check Location Accuracy section in the Menu Bar chapter for more
information.
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The Corrected/Raw selection box is used to choose whether or not you want vxscan
to apply radiometric corrections to the image as viewed on the image monitor. With the
Corrected mode, vxscan applies the radiometric calibrations to correct the image.
This includes applying all the current radiometric settings and calibrations to correct for
backlight and lens fall-off distortions. With the Raw mode, vxscan does not perform
these corrections, making it especially useful when working with color images where
the corrections take more time. Use Raw for faster camera movement during random
viewing. Use Corrected for a more accurate preview and for determining brightness
and contrast settings.

Color Monitors and Color Balance

When working with color images in Corrected mode, adjustments to any settings which
change the scanner state, such as Contrast/Brightness, require vxscan to not only
recalculate all of the radiometric settings, but also perform color dithering on the image.
Dithering is necessary because the scanner scans using a range of 16 million colors,
while display monitors and their associated image processing boards only have the
capability for 256 colors. This dithering process takes time and will alter the spatial
resolution that you see on the image monitor. If you wish to see the preview image
more quickly, turn off the Corrected mode (use Raw).

VX3000 Film Scanner User's Manual 39



Current ROI Description

The settings within the Current Region of Interest Description are similar to the Current
Scanner Settings with the major difference that the Current ROI settings are those
actually used at scanning time, whereas the Current Scanner Settings are for making
adjustments while previewing the image.

Lurrent Region of Interest Description
{Color o] [Positive @] |Photo: l/fi lesB/scans/trees.p T ilesb/scans/aspen
1less/scans/birch
{Density [=] ] | Default LUT uj ROI: I /¥1ilesb/scans/cedar ]
i L les&/scans/ fir
Resolution Inage: | /ftlesS/scans/cedar] I
10,0 un/pixel |Raster o] |8-Bit al| | on veximg &
Contrast Brightnesa | Normal o| [Ho Memo =] [Purge o |
L 1,000 ! I +0,300 _l mm plxels
I| 1.000 I +0.240 ! Wigth: 100.000
[ 1.000 [ +0.35 | Height: 80.000 8000 [+ e—ee— ]

Resolution and Radiometric Controls

The resolution and radiometric controls are the same in the Current ROI Description as
they are in the Current Scanner Settings with the following exceptions. The Resolution
control does not display a separate dialog box with slider controls. Instead, you have
only the option of entering a specific resolution value in the text box. Similarly, the
Contrast and Brightness controls provide only text boxes for entering specific values.

Apply to Scanner

This button applies all of the settings within the Current Region of Interest Description
to the Current Scanner Settings. Changes you make to the Current ROI Description are
not automatically used by the Current Scanner Settings when you preview the image.
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You must use the Apply to Scanner button to apply those settings to the Current
Scanner Settings in order to preview the changes on the image monitor.

File Names

Each Region of Interest has associated with it the name of the Photo file to which it
belongs, an ROI name, and an Image name. The use and conventions of each of these
file names is described below.

Photo File

A Photo File name can be assigned to each photo that is mounted for scanning. Within
each Photo File, one or many Regions of Interest (ROIs) can be defined, each with a
specific ROI File name. In addition, muitiple Photo Files can be viewed and used at
one time. Each Photo File has a system name with a .ph extension and an optional
description called a Photo ID. New Photo Files may be named anything you want, as
long as they follow UNIX naming conventions and have a .ph extension. Photo Files
do not need to be saved in order to scan an image, but you must save Photo Files if you
want to preserve the scanning parameters and any digitized points.

When you open an existing Photo file, all of the Regtons of Interest for that Photo file
are displayed in the list of regions on the right. The name of the current Photo file is
displayed in the Photo description field and the name of the currently selected Region
of Interest is displayed in the ROI field. You can open as many Photo files as you
want, each with varying numbers of ROIs.

Default Photo File

Vxscan uses a default Photo file, default.ph, when the application is first started. This
default file can be used to store scanning parameters that are used often. For example,
if you are scanning a set of images that all use the same resolution, contrast, and
brightness settings, those settings can be stored in the default.ph file, saving you time
when you scan each image. Because default.ph is an actual Photo file, you must save it
as you would any other Photo file in order to save your default scanner parameter
settings. The default.ph file must be located in the current working directory from
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which you run vxscan to be used as a default file, otherwise, vxscan uses the system
defaults.

Note: Loading a Photo File changes the Current ROI to be the first ROl in the Photo
File, and changes the ROI Settings appropriately, but does not affect the Current
Scanner State. The .vxscanrc file specifies the Current Scanner State when the vxscan
user interface first begins.

ROI Files

Scanned regions are stored in directories that are created using the file name specified in
the ROI field. This directory is where tiles, information files, and, if you do not
specify a directory name in the Image field, formatted images are stored. For
example, if you specify /directoryl/regionl as the ROI name, an image directory called
regionl 1s created under the directory /directoryl. /directoryl must already exist and
have write permissions. The scanned regions are given file extensions to specify the
type of image file. See File Naming Conventions for the extensions that vxscan
assigns. Vxscan uses the default ROI directory name, Untitled, until you supply one.
If you decide not to supply an ROI file name and use the default name of Untitled, a
directory called Untitled is created in your current working directory when you scan.

Note: Images can become very large, and scanning in color requires three times the
amount of disk space as a monochrome image, so select directories accordingly.

To name the current Region of Interest,

1. Click on the ROl input field. Use the Backspace or Delete keys to delete any
existing name such as "Untitled."

2. Type afull path name (if different than the directory in which you are working)
followed by the new directory name for the Region of Interest. The name appears
in the list of regions on the right when you click outside the text field or press
<Return>. Vxscan checks to see if you have write permission for the given
directory.
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Note: All systems shipped prior to August 1993 have a maximum RO directory name
of eight characters.

Image Files

Because of the potentially large size of scanned image files, you have the option of
storing the raw scanned tiles in a different location than the final formatted image or
Photo File itself. The Image field is an optional directory where the final formatted
scanned images are stored separately from the raw scanned tiles. The directory
specified must already exist. Vxscan creates a sub-directory in the specified image
directory which has the same name as the ROI directory name. If you do not enter a
different directory name in this field, the formatted scanned images are stored in the
same directory that you have specified in the ROI ficld.

Vxscan also allows you to specify a remote host machine on which the formatting
software executes. The formatting process will run much faster if the image directory
is a directory on a disk resident on the formatting host. See Host Machine in this
chapter for more information.

List of Regions

Within the Current Region of Interest area, the list of regions displayed on the right are
either ROIs that you have created or ROIs contained in an existing Photo File. If you
have more than one Photo File opened, all of the regions from all of the Photo Files are
listed in Photo File order.
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/files3/im/ohio

/files3/im/montany
/files3/im/florid

Scan All

File Naming Conventions

Although you provide the Photo file, ROI and image names, vxscan appends certain
file extensions when storing the scanned images. Every scanned image is assigned an
information header file using the extension, .rh. Every raw tile is a file which has its
tile number appended. For example, region1nnmm.w, where

nn = tile number in x (across)
mm = tile number in y (down)
w = the color channel (monochrome in this example)

In the example above, a monochrome image has the extension .w appended. When
you select color scanning, the three color bands - red, green, and blue - are stored in
separate files as tiles, but the resultant image may be stored in a single file if BIF (band
interleaved) is selected. Color image tiles have the extensions .r, .g, and .b appended.
In addition, each of the formats has its own extension appended, such as .bsf or .bif.

For example, a monochrome scan in a BSF (band sequential file) format would have
the following files:
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regtonl.rh
regionl.bsf.w

The following example is a color (RGB) scan in BSF format:

regionl.rh

regionl.bsf.r
regionl.bsf.g
regionl.bsf.b

File Processing and Storage

Vxscan uses several settings in the Current ROI Description to determine how the
image will be processed and stored: format, bit-depth, host machine, and whether the
raw tiles are purged or preserved.

Format
Vxscan has several formats in which the scanned images can be stored.

« Native - raw tiles, not yet formatted together.
+ Raster - Sequential pixels, column major order. Band sequential or band
interleaved determination is based on bit depth as specified below.

Bit Depth

In addition, vxscan provides choices of bit depth, either 8-bit or 24-bit. 8-bit is
used for either monochrome images or band sequential color. 24-bit is for color
images which are to be formatted as band interleaved by pixel.

Formatting Host

Because formatting scanned images can take more time than the scanning process,
depending on the capabilities of the formatting host, vxscan allows you to designate a
remote host machine on which the formatting software executes. The selection box just
to the right of the bit depth box lists the available machines. In most system
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configurations, greatest speed will be achieved by selecting the host on whose disk the
resultant image data is to reside. See the Setup and Calibration chapter for information
on setting up host machines.

Purge or Preserve

Vxscan provides the option of saving or deleting the raw scanned tiles. Because the
tiles can take up a large amount of space, you can choose to have them deleted as the
image is formatted. Preserve saves the tiles in the directory you designate in the ROT
field. Purge deletes the tiles while the image is being formatted, and is generally the
desired choice.

Memo

The Memo field can be used to type in descriptive information or comments about the
current Region of Interest. This is helpful in keeping track of scanned images because
the ROI file name may be too short and the scanning parameters not descriptive enough
to clearly identify the region. The memo information is stored in the saved Photo file.

Region of Interest Size
The current Region of Interest's size is determined by three variabies:

+ Resolution (in micrometers per pixels or dots per inch)
+  Size (in inches or millimeters)
+ Size in pixels

Changing any of these variables will affect the others. For example, if you change any
one of the variables either by typing in values or by rubberbanding the ROI rectangle,
the other values will change accordingly.

One of these three variables is calculated from the other two, and may not be specified
dynamically. For example, if you select Resolution for automatic calculation, you can
alter the size of the Region of Interest in inches or millimeters and the size in pixels.
Vxscan will then automatically calculate the resolution. You can select which one of
these variables vxscan will automatically calculate for you by setting the Auto Calculate
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Dimension in the vxscan Preferences selection box under the Options menu. See
Options Menu in the Menu Bar chapter for more information.

Millimeters/Inches

Millimeters or Inches specifies the width and height of the scanned area. This
dimension is measured either in metric with millimeters or in English with inches,
according to the units you select in the vxscan Preferences selection box.

Pixels

Pixels specifies the size of the scan area in pixels.

Scanning

If you have created multiple ROIs, you can either scan them one at a time or all at once
in sequential order.

Before scanning, make sure you have:

« Defined the Regions of Interest and supplied an ROI name for each.

« Set all of the scanning parameters in the Currcnt Region of Interest area for each
region you are scanning.

» Saved the Photo file if desired. (You can also do this after scanning.)

» Reflected all desired preview settings from the Current Scanner Settings to the
Current ROI by using the Apply to ROI button.

« Estimated the approximate size of the scanned image(s) and provided adequate disk
space.

Scanning a Single ROI

1. Select the area you want to scan (if there is more than one region listed) by clicking
either on the ROI rectangle in the Backplane Representation or on the name of the

48 VX3000 Film Scanner User's Manual



Current ROI Description
Scanning

region in the list of regions. The ROI name will be highlighted and its rectangle
drawn in red.

2. Select Scan. The vxscan Working window appears, providing messages about the
progress of the scan. An information request window appears when the scanner
has finished scanning to inform you that the scan is complete.

3. Select OK.

Scanning Multiple ROIs Sequentially

1. First make sure to delete or close all unwanted ROIs and Photo files including
default.ph and Untitled.

Note: Every open Photo file must have at least one corresponding ROI. Therefore, if
you delete the last ROI for a Photo file, vxscan will generate a new ROI using default
parameters. You must close the Photo file to remove the last ROL

2. Select Scan All. The scanner scans all of the areas in the list of regions in the
order in which they appear. The system highlights the area it is currently scanning
and displays the vxscan Working message box providing messages about the
progress of the current scan.

Note: At any time after you have started to scan, you can stop the scan by selecting the
Cancel button within the small "Working" box. Depending on the image being
scanned, the scanning process may take a moment to stop.

VX3000 Film Scanner User's Manual 49



Menu Bar

Efile Edit View (ptions ﬁalpl

The menu bar displays four pull down menus and a help menu. Located within the puil
down menu items are options to create and save files, to digitize points, to control the
behavior of vxscan, and to exit the application.

File Menu

The File menu, located under the menu bar, contains the following options:
New
Open
Close
Save
Save As
Exit

These options allow you to create or alter Photo files, custom LUTS, and the
initialization file, .vxscanrc. The File menu also has the option of exiting from vxscan.

New

The New option creates a new Photo file in addition to any existing ones. New
changes the current ROI to be the first ROl in the newly created Photo File, using the
ROI values from the last ROI in the previous Photo file. When you select New, you
will see default.ph assigned as the default Photo file name and Untitled as the new
ROI name.
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Open

When you select the Open option, you have two choices:

Photo
Custom LUT

Selecting Photo allows you to open a previously saved Photo File. When you select a
Photo file name using the file selection box, the scanning parameters for the first ROI
stored in that file appear in the Current ROI Description, and additional scan areas that
were previously defined appear in the list of ROIs.

Selecting Custom LUT allows you to choose a previously created custom look-up
table (LUT) that will "map" the scanned image values to alternate values.

By using Open/Custom LUT/Monochrome,Red,Green,Blue, you can load a LUT for
each color channel. If a LUT has already been loaded for a given channel, it will be
closed and replaced. Close/Custom LUT/Monochrome,Red Green,Blue removes the
association between a LUT and a color channel. For more information about how LUT
files are used, see the Lookup Tables(LUT) section.

File Selection Box

When you open, or save as, a file, a file selection box appears with the following
fields.
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Filter

I/FLlesB/images/*.ph

Directories Flles
aspen.ph

/files3/images/.. || balsam.ph
/Files3/images/alat] cedar.ph
/Piles3/1mages/alas[ default.ph
/¥files3/images/Flor elder,ph
/files3/images/geon forest.ph
/¥iles3/images/idat grape.ph
/files3/images/ind: hawthorne, ph

1 KX . - [« B
Selection

[/Piles3/images{;

Filter
The Filter box displays the current directory filter being applied to this directory name

search. The Filter determines which file names will be displayed in the Directories box.
The Filter uses regular UNIX naming conventions.

To start the search using the filter,

1. Click in the Filter box and type the directory where you think the file is located, an
asterisk, and the extension if one exists. Use the Backspace and Delete keys if

necessary. The asterisk is used as a wild card so that any file with that extension
within that directory will be displayed.

2. To make the Filter take affect, click on the Filter button at the bottom of the box.
You can also press Return instead.
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Directories

The Directories box lists all the directories which reside below the specified directory in
the filter box. To scroll through the list of directories, click on either the up and down
arrows. To see the entire path, click on the left or right arrows.

To select a directory, use one of the following:

+  Double click on one of the directories listed in the Directories box to highlight it and
the Files box then lists those files for the directory you selected.

+  Click on the directory you need and press the Filter button.

To go up one directory the directory tree, double click on the directory name which is
followed by two dots (/files3/images/.. in the above example).

Files
The Files box lists the files in the specified directory that match the filter.

To select one of the files in the Files box,

Click on one of the files in the Files box. That file name appears in the Selection box.

Selection

The Selection box displays the current file you have selected. You can either use the
Filter, Directories, and Files boxes to search for and select a file, or if you already
know the name, you can type it directly into the Selection box.

Close

The Close option closes the current Photo file. If you have made changes without
saving, you will be prompted to save your changes. When you close the last Photo file
you opened, the default Photo file, default.ph, will remain along with the default ROI,
"Untitled.” (If there is no default.ph, the system program defaults are used.)

Save

The Save option saves either the current Photo file or the .vxscanre file. If you are
using an existing Photo file when you select the Save option, all changes are saved to
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that file. The Save option saves the current Photo file to the name listed in the Photo
file name box.

The .vxscanrc file is a startup file that contains the desired state of the scanner
parameters when vxscan begins. To create and save a .vxscanrc file, correctly set all
the settings in the Current Scanner State area and then select Save/.vxscanrc. The
settings will be saved in the .vxscanrc file in your home directory and will be used as
the initial setup state next time vxscan is started.

Save As

The Save As option saves a Photo file to a new file name so that you can create another
file while preserving the original file. The new Photo file name is specified in a File
Selection Box, which is described above. Save As only works with Photo files, not
with the .vxscanrc file.

Exit

The Exit option exits vxscan and returns to the UNIX prompt. A window may appear
prompting you to save any changes you may have made to the Photo file. This option
also shuts down the scanner. It is recommended that you always exit vxscan in this
way. Exiting either via the X Window's window manager menu or other termination
methods prevent the application from properly terminating remote processes (e.g.
vxformat), and may have undesirable effects on the scanner controller state.

Edit Menu

The Edit menu, located under the menu bar, contains the following options:
New ROI
Delete ROI
Release Point
Delete Rectangle
Photo Info
Acquire Points
Acquire Centers
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New ROI

The New ROI option creates a new Region of Interest in the current Photo File. When
you select New ROI, a new ROI appears with the name Untitled. The new ROI uses
the settings such as resolution and saturation from the previous ROIL. See the section,
Naming a Region of Interest in the previous chapter for information on changing the
ROI name. See Drawing an ROI Rectangle in the Current Scanner Settings chapter for
more information on positioning the new ROI. Also see Resolution and Radiometric
Controls for information on changing the ROI parameters.

Delete ROI

The Delete ROI option deletes the current RO, including the name, any parameters you
have set, and the ROI rectangle.

1. First make the ROI you wish to delete the current ROI by either highlighting the
ROI name in the list of regions or clicking on the rectangle in the Backplane
Representation,

2. From the Edit menu, select Delete ROI.
Note: You cannot delete the last ROl in a photo, as each Photo file must contain at

least one ROL. If you attempt to do so, a new ROI will be created with the default
parameter sertings.

Release Point
This option releases the currently active point on the current ROI rectangle.

1. First make sure that the point you want to release is currently active. If not, click
on the point to make it active. The current point is drawn in red, others are drawn

in magenta.

2. From the Edit menu, select Release Point. The point is deleted and the
rectangle is recalculated based on the remaining points or the indicated size.
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Delete Rectangle

The Delete Rectangle option deletes the current ROI rectangle in the Backplane
Representation. Only the rectangle position is deleted, not the RO itself.

1. Make sure the rectangle you want to delete is current. The current ROI rectangle is
drawn in red, other rectangles are drawn in magenta.

2. From the Edit menu, select Delete Rectangle.

Photo Info

The Photo Info option is used to assign a Photo ID and additional comments to a Photo
File. This is helpful in keeping track of scanning projects because a Photo File's name
may be too short to clearly identify the Photo File. Using the Photo ID field and the
comments field can help you further identify files.

To assign a Photo ID or change an existing one,

1. From the Edit menu, select Photo Info. The following selection box appears:
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4,

5.

Photo Information

Ll s anc s teess th
/filesb/scans/clties.ph
/filesbs/scans/roads.ph

Current Photo

Photo ID:

[ﬁehuret;p

Comment:

Phota of commaon tree
types.

The top portion of the box shows you the Photo file names of all of the open Photo
Files.

Click on the Photo file name you want to look at or change.
Click in the Photo ID field and type in a new Photo ID (or change the existing one).

You can optionally click in the Comment field and type in comments.

Select OK.

Acquire Points

The Acquire Points option is used to digitize points of interest on an image and save
themn along with the scanned image for later post processing.
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To digitize points,

I. From the Edit menu, select Acquire Points. The following selection box
appears:

2. Highlight a point of interest in the list, for example, "fid1" (fiducial).

3. Move the camera and zoom to the resolution required for your application over the
point you want to digitize.

4. Digitize the point using the left mouse button. An asterisk appears next to the point
name listed in the Acquire Points box.

5. Continue using the above steps to digitize additional points.

Undo simply undoes your last action, a delete or an undo.
Delete deletes the current (highlighted) digitized point.
Cancel exits the Acquire Points box without preserving any digitized points.

6. When you are done digitizing, select OK.
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Note: Digitized points are stored in the Photo file and are only saved if you save the
Photo file prior to exiting vxscan.

Post Processing

When points are acquired in vxscan the point names and corresponding X and Y
coordinates are stored in the photo file and can be used in post processing. Points are
stored in both scanner coordinates (microns from the upper left hand corner of the
scanner) and in photo coordinates. You can also write your own software to read data
from the Photo files. Vexcel Imaging can supply a library of C functions which you
can call to access the information. See the Vxinfo Documentation manual for more
information on how to use these utilities.

Acquire Centers

The Acquire Centers option is similar to Acquire Points but gives you much greater
accuracy than hand digitized points. Acquire Centers calculates the center of each point
to sub-pixel accuracy of one-tenth of a pixel. Acquire Centers is used as part of the
geometric accuracy test for the scanner and gives you confirmation that the scanner is
working properly.

The Acquire Centers computation requires that the points be centrally symmetric and
light-colored against a darker background. The pug holes (circular holes drilled in the
film emulsion) use by many photogrammetrists meet these requirements. Poor contrast
or not symmetrical points could cause vxscan to miscalculate the point.

Note: Always use the highest resolution possible when acquiring centers and make

sure that the Current Scanner State is set such that the points you will be capturing with
Acquire Centers have high contrast.
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1. From the Edit menu, select Acquire Centers. The following selection box
appears:

center
center
center
center

Calculate

2. Highlight a point of interest in the list, for example, "centerl".

3. Move the camera and zoom to the resolution required for your application over the
point you want to digitize. You will see a green box on the image monitor which
you can resize over the point by moving the upper left and lower right corners.

This box is used to constrain the area that vxscan uses for calculating a center. The
box narrows the search region, isolating the point from other radiometric highs.

4. Press Calculate to find the point value. A plus sign (+) is displayed on the image
monitor confirming the point and an asterisk appears next to the point name listed in

the Calculate Centers dialog box.

5. Continue using the above steps to acquire additional centers.

Undo simply undoes your last delete or undo.

Delete deletes the current (highlighted) digitized point.
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Cancel exits the Calcuiate Centers dialog box without preserving any digitized
points.

6. When you are done acquiring centers, select QK.

Note: Acquired centers are stored in the Photo file and are only saved if you save the
Photo file prior to exiting vxscan.

Like Acquire Points, acquired centers are stored in, and can be retrieved from, the
Photo file. See the Post Processing section above for information on extracting the
acquired centers data.

View Menu
The View Menu contains the following options:

Clean
Histogram

The Clean option is used when cleaning the reseau glass. The Histogram option is
used for viewing the histogram representation of the camera field of view.

Clean

This option simply turns off the scanner backlight and turns on the reseau for a fixed
period of time to illuminate the glass for ease of cleaning. From the View menu, select
Clean. A message appears telling you how many minutes you have until the backlight
comes back on. You can turn the reseau light off at any time by selecting Cancel.

Histogram

The Histogram option displays a single histogram for monochrome images and three
histograms for color images, one each for red, green, and blue. The histogram can also
be displayed by selecting the Brightness or Contrast buttons. See the section, Contrast
and Brightness for complete information on using the Histogram.
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Options Menu

The Options Menu is used for setting system preferences that affect the way you set
your scanning parameters and define your Regions of Interest.

Set Preferences

The Preferences option allows you to control various aspects of how the application
behaves. With Preferences you set the units of measurement, select a dimension for
automatic calculation, and enable or disable Photo coordinates.

To display the Preferences selection box,

From the Options menu, sclect Set Preferences. The following selection box
appears:

@ Metric
< English

3 Check Location Accuracy:

< Yes

% No

8 Proto Coordinate System:

& Yes

& No
i Auto Calculate Dimersion: |4
. ¢ Resolution

< Size {n mm/inches

4 5ize 1n pixels
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Units

The Units setting determines which units of measurement will be used, either English
(size in inches, resolution in dots per inch) or metric (size in millimeters, resolution in
um/pixel). To select a type of unit, click on the toggle button next to the units you
want.

Check Location Accuracy

If you select Yes for Check Location Accuracy, you will see a warning message box
appear when the coordinates positioned are approximate, not accurate. If you select
No, the messages about accuracy are turned off. See Accuracy in the Current Scanner
Settings chapter.

Photo Coordinate System

Select Yes if you want to see the photo coordinate system rectangle displayed in the
Backplane representation when defining Regions of Interest. Select No if you do not.

The ROl locations and acquired points are stored in both scanner and photo
coordinates. Scanner coordinates are in microns from the upper left hand corner of the
scanner. A photo coordinate system may be established relative to the film, so that
photo coordinates may be used in a post process to tie ROI locations or acquired points
back to locations on the film. Accurate photo coordinates require that you be in
Accurate mode when establishing the coordinate system.

In the backplane representation, the small box in the upper left corner of the photo
coordinate box is the origin of the photo coordinate system and is set to 0,0. The lines
at right angles from this 0,0 origin represent the X and Y extents. The 0,0 origin and
the X extent of the photo coordinate box can be positioned over a known point on your
image such as a fiducial mark., The Y extent is used to determine the handedness of the
coordinate system.

Auto Calculate Dimension

Vxscan uses three variables to define the dimensions of an ROI: resolution, number of
pixels, and height/width in either inches or millimeters. One of these dimensions is
calculated while the other two are defined by the user. The Auto Calculate Dimension
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option is used to specify which dimension you want automatically calculated. The two
dimensions you do not select for automatic calculation then become variables for which
you can enter the information. For example, if you select resolution for automatic
calculation, the vxscan window provides input fields next to the size in mm/inches and
size in pixels to allow you to type in the information,

Remember that the choice you make for automatic calculation affects your control of
those dimensions. For example, if you have selected "Size in mm/inches" for
automatic calculation, you will not be able to dynamically resize an ROI rectangle in the
Backplane Representation because the system will compute the dimensions for you.
Likewise, if you have selected to have the resolution automatically calculated, you will
not be able to adjust the resolution, only the size in pixels and the size in mm/inches.
See Region of Interest Size in the Current Scanner Settings chapter for more
information about how this option affects your region size.

VX3000 Film Scanner User's Manual 65



Appendix A: Filtel‘s

Image processing hardware in the scanner controller supports high speed convolution
of a so-called kernel with an image. The default sharpening kernel for the VX3000
Film Scanner is a 3 x 3 array:

0 -1 0
-1 8 -1
0 -1 0

followed by a division by four. In the process of convolution, this kernel may be
thought of as being moved across the image so as to be centered over each pixel. The
gray value of each of the nine pixels in the 3 x 3 neighborhood is multiplied by the
kernel value on top of it; these products are added together and the sum is divided by
four. This is the value of the pixel in the output image which occupies the same
position as the one upon which the kernel is centered. This is an example of a high
pass filter. It exaggerates differences between neighboring pixels, which is why the
kernel is positive in the middle and negative at the edges. The division by four is
required to prevent a changed in the average gray level of the image; i.e.,
0-1+0-1+8-14+0-1+0/4=1.

The calibration file filrers.cal is an ASCII file which contains several kernels used in
processing scanner images. A knowledgeable user could customize the
VL_ENHANCER kernel (the one used when Sharpen is selected) to be a more
aggressive high pass filter. However, one should remember that sharpening also
enhances noise, graininess, etc. It is recommended that the VI,_SHARPEN and the
VL_LOWPASS kemnels not be modified; they are used to remove artifacts introduced
by image resampling.
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Suppose we have a transparent filter illuminated by a beam of light:

Incident Light Transmitted Light

—>

Intensity = Ij Intensity = It , It < [

There are three common measures of the degree to which the filter absorbs light:

(1) Transparency (T) = % 0<Tx<1.0
(2) Opacity (O) = L L 1.0 < 0 <o
P - T - It ==
I-
(3) Optical Density (OD)= logio(®) = log1o (I_i) 0.0 < OD < oo

Restating the above definitions in words:

(1} Transparency is the ratio between the intensity of the transmitted light and the
intensity of the incident light.

(2) Opacity is the reciprocal of the transparency.
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(3) Optical Density is the common logarithm of the opacity.

An example: Suppose a filter blocks 50% of the incident light. Then

(1) Transparency = 0'?_ li = 0.5
i
. 1
(2) Opacity = Transparency = 2.0
(3) Optical Density = log10 (Opacity) = 0.301

So, the reason to deal with logarithms (optical density) is because the interactions
between multiple optical components which are mulriplicative in terms of transparency
and opacity become merely addidive in optical density.

Filterl Filter2
— —_—
Ii Ity Ity
Iy Ity

Solving for Ity we get
Ity = (T1 : T2) Iy

So, if we combine two filters which each block 50% of the incident light, what is the
transparency of the pair taken together? The first one blocks half the light (T] =0.5)

and the next one blocks half of what the first one blocks, so T =0.5-0.5=0.25
Opacity =% =4.0 and
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OD = log 10 (Opacity) = log 10 (4) = 0.602
OD (Filters 1 + 2) = OD (Filter 1) + OD (Filter 2)

This is the full reason why we perform a densemap calibration and make all of our
radiometric corrections in a "density linear” space. If we neglect the spectral response
of the sensor, the CCD array is roughly an intensity meter (it counts photons striking
each of its pixels). If output voltage is proportional to light intensity, and the A/D
converter of the digitizer is linear, then each gray value spans the same light intensity
difference (i.e., is some constant number of photons wide). This is "intensity linear"
space.

We remap pixel gray values through a Look-Up Table (LUT) called the Density Map to
make them density linear. Then fall models and backmodels are simply added to the
density-linear image for radiometric correction. (Note that fall models and backmodels
are expressed in optical density). This works at all backlight intensities and neutral
density filter selections of the scanner.

So the question is: How does the choice of intensity vs. density linear affect the way
an image looks?
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Histogram of Intensity Linear Step Wedge in Density Linear Space
Small AT —>Large AOD Large A T-> Small AOD
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Setup

Before beginning vxscan, certain UNIX environment variables must be correctly set.
Typically, these variables are already set up within the .cshrc file in the user's home
directory. If not set properly during the login process, these variables will need to be
set from the command line.

The host workstation must grant permission for the scanner controller to use it as an X
host. From the host workstation, type:

xhost controller name
See the Installation Manual for more information on setting the xhost autornatically.

Log on to the controller (must have an account on the controller).
Either add the following commands to the .cshrc file, and then source it, or type them
in at the command line:

setenv VX_HOME value (default set at installation: /files/vexcel/cal
this is the directory where the
mastername file resides)

setenv DISPLAY hostname:0.0

setenv VX_PRINT_LEV value (sets print level; set to O for more speed
and less printout; for diagnostics, set to
5, for example)

For more information about setting environment variables, see the Installation Manual.
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Calibration

The VX3000 scanner must be calibrated before using. See the Instailation Manual for
more information and contact Vexcel Imaging Corporation before beginning.

During the normal installation and calibration process, a file is modified which contains
information about available formatting hosts on the network. Also, at that time, the
formatting program vxformat is installed on those hosts, file systems are mounted on
the scanner controller, and common accounts are created on both the formatting hosts
and the scanner controller. If more hosts are to be added, please see the Installation
Manual for further information on how to do so.
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.vXscanrc

saving 55
24-bit 46
8-bit 46

A
Accuracy 38
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Accurate mode 22, 38, 64
Acquire centers 60
picture 61
Acquire points 58
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Application
starting 7
Apply 48
current ROI settings 16

current scanner settings 15, 16

LUT to ROI 28
to ROI 38, 48
to scanner 41
use with color 35
Approximate mode 22, 38
Aspect ratios 23
Auto calculatate
dimension 64
Auto calculate 47
resolution 29
size in mm/inches 23

B
Backplane §, 19
Backplane representation 19
scroll bars 23
Band interleaved format 46
Band sequential format 46
Bit depth 46
Brightness 29
adjustment of 31, 32
slider 31
BSF format 45, 46

C
Calibration 76
Camera

moving 21
Camera field of view 19, 20

effect of resolution on 29
Cancel button 4
Clean 62
Clean option 8, 62
Cleaning

solution 8

technique 8

the glass 8
Close 54
Color 25
Color balance 39
Color histogram 34
Color monitors 39
Color scanning 43
Comment

in photo info 58
Contrast 29
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adjustment of 33, 34
setting for color 35
slider 31
Conventions
user interface 2
Corrected mode 38, 39
Current ROI 13
description 16
rectangle 20
Current ROI description 41
Current ROI description picture 41
Current Scanner Settings 13, 15, 19
Cursor
image monitor 21
in camera field of view 21
shape 2, 22
Custom LUT 27
close 28
open 28

D
default.ph 42, 51, 54
Delete rectangle 23, 57
Delete ROI 56
Density 25, 26

using 27
Digitizing points 58
Directories 54

DISPLAY environment variable 7, 75

Drawing ROI rectangle 21

E
Edit menu 55

Environment variables 75
Ethernet 2
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Exit 55

F
Fiducial points 59, 61
File format 46
File menu 51
File names 42
color images 45
File naming conventions 45
File processing and storage 46
File selection box 52
directories 54
files 54
filter 53
Files 54
Film
emulsion 8
mounting 8
Filter 29, 53
discussion of 67
Format 46
band interlecaved 46
band sequential 46
BSF 45, 46
native 46
raster 46
Formatting host 2, 44, 46, 76

G
Glass

cleaning 8
Gray value 30, 31

H
Histogram



Index

adjustment of 32, 33
color 34

color, picture of 36
displaying 30, 62
figure 31, 32, 33, 34

monochrome, picture of 30

sliders 31
Host

formatting 46, 76
Host workstation 2

I
Image
mounting 8
Image directory 44
Image monitor 2, 15, 16, 29
color display 39
cursor 3
Image type 25
Inches, size in 48
Input fields 3
Intensity 25
using 27
Intensity vs. density 69
Introduction 1

L
List of regions 44
picture 45
Location accuracy 64
Look up table 27, 71
color 28
creating 28
LUT 27,71
close 28

color 28
creating 28
open 28

M
Memo fieid 47
Menu bar 13, 14
Menus
pulldown 4
Message boxes 4
Millimeters, size in 48
Monochrome 25
Mouse
clicking and dragging 3
peinter shape 2, 22
using 2

N

Native format 46
Negative 25, 38
New 51

New ROI 56

0
Opacity 25, 26
Open
custom LUT, color 52
Options menu 63

P
Photo coordinate rectangle 20, 24
Photo file 44

closing 54

creating new 51

default 42
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Index

name 42
open 42
opening 32
photo information 57
saving 54
Photo ID 57
Photo information 57
Pixels
size in 47, 48
Positive 25
Post processing 60
Preferences 48, 63
Preserve 47
Purge 47

Q
Quitting the application 55

R
Radiometric Controls 24
Current ROI 41
Radiometric corrections 38, 39
Raster format 46
Raw mode 38, 39
Region of Interest
description 11
drawing rectangle 21
Release point 22, 56
Reseau 8
Reseau light 8, 62
Resolution
Current ROI 41
RO size 47
setting 28, 29
slider 28
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Resolution and radiometric controls 24

RGB 25
Roam 21
ROI 38

accurate positioning 22

creating new 56
deleting 56

deleting rectangle 23
description 11
drawing rectangle 21

dynamically resize rectangle 23

input field 43
making current 23
naming 5
positioning 22
size 5, 47

ROI file 43
default 43

ROI name 43

ROI rectangie 21
deleting 57
releasing point 56

S
Save 54
Save as 55
Scan 49
Scan All 49
Scan area
defining 6
Scanner 2
homing sequence 7
starting 7, 8
Scanner controller 1



Index

Scanning 48
errors in 8, 9
multiple ROIs 49
one ROI 48
overview 5
Selection box 3, 54
Setup 75
Sharpen 29
Size
in mm/inches 47, 48
in pixels 47, 48
Starting the scanner 7
Startup file
saving 55
System configuration |

T
Text input fields 3
Tile numbers, in file names 45
Tiles

purge or preserve 47
Transmittance 253, 26

U

Units, setting 64

Untitled 43, 51, 54

User interface
conventions 2
overview 11
starting 7
window 13

v
Vexcel format 46
View menu 62

VX_HOST environment variable 75
VX_PRINT_LEV environment variable
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